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CONTACT INFORMATION 

Giga-tronics, Incorporated 

4650 Norris Canyon Road 

San Ramon, California 94583 

Telephone:  800.726.4442 (only within the United States) 

 925.328.4650 

Fax: 925.328.4700 

On the Internet: www.gigatronics.com 

 

 

  

Warranty 

Giga-tronics GT-8550A Series USB Power Sensors are warranted 
against defective materials and workmanship for one year from 
date of shipment. Giga-tronics will at its option repair or replace 
products that are proven defective during the warranty period. 
This warranty DOES NOT cover damage resulting from improper 
use, nor workmanship other than Giga-tronics service. There is 
no implied warranty of fitness for a particular purpose, nor is 
Giga-tronics liable for any consequential damages. Specification 
and price change privileges are reserved by Giga-tronics. 
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Regulatory compliance information 
 

This product complies with the essential requirements of the following applicable European 
Directives, and carries the CE mark accordingly. 

 

89/336/EEC and 73/23/EEC    EMC Directive and Low Voltage Directive 

EN61010-1 (1993)      Electrical Safety 

EN61326-1 (1997)      EMC – Emissions and Immunity 

 

Manufacturer’s Name:    Manufacturer’s Address 

Giga-tronics, Incorporated    4650 Norris Canyon Road 

       San Ramon, California 94583 

       U.S.A. 

 

Type of Equipment:     Model Series Number 

USB Power Sensor      GT-8550A 

 

Model Numbers: 

GT-8551A, GT-8552A, GT-8553A, GT-8554A, GT-8555A, and GT-8888A 

 

 

 

Declaration of Conformity on file. Contact Giga-tronics at the following; 

Giga-tronics, Incorporated 

4650 Norris Canyon Road 

San Ramon, California 94583 

Telephone:  800.726.4442 (only within the United States) 

 925.328.4650 

Fax: 925.328.4700 
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Record of Changes to This Manual 
Use the table below to maintain a permanent record of changes to this document. Corrected 
replacement pages are issued as Technical Publication Change Instructions (TCPI). When you are issued 
a TCPI, do the following: 

1. Insert the TCPI at the front of the manual binder. 

2. Remove the pages from the manual binder that are noted in the TCPI. 

3. Replace the page(s) removed in the previous step with the corrected page(s). 

4. Record the changes in the table below. 
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1 Safety and Manual Conventions 
 

This manual contains conventions regarding safety and equipment usage as described below. 

1.1 Product Reference 
Throughout this manual, the term “GT-8550A” refers to all models of power sensors within the 
GT-8550A Series, unless a specific model power sensor is referenced. 

 

1.2 Personal Safety Alert 

WARNING: Indicates a hazardous situation which, if not avoided, could result in 
death or serious injury. 

 

1.3 Equipment Safety Alert 
CAUTION: Indicates a situation which can damage or adversely affect the GT-8550A or 
associated equipment. 

 

1.4 Notes 
 Notes are denoted and used as follows: 

NOTE: Highlights or amplifies an essential operating or maintenance procedure, practice, 
condition or statement. 

 

 

 

 

 

 

 

 

 

 

 

         WARNING ! 

CAUTION 
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2 Introduction 

2.1 Overview 
NOTE:  In this manual, the GT-8550 Series USB Power Sensor is referred to generically as the “GT-8550A” 
for simplicity. The specific model of power sensor is used where necessary. 

This manual provides information about the installation and operation of the GT-8550A Series USB 
Power Sensors. Product description, specifications, and support are included. Changes to this manual 
are recorded in Record of Changes to This Manual in the front section. 

The GT-8550A features a frequency range to 26.5 GHz, wide dynamic range, fast measurement speed 
and a rugged body that connects directly to a desktop or laptop computer using a standard USB port and 
USB cable. A separate power meter is not required. The GT-8550A Series USB Power Sensors allow for 
immediate conversion of RF and microwave power into digital data right at the point of power sensing. 
The GT-8551A, GT-8552A, and GT-8555A models feature triggering capabilities. (Refer to the 
Specifications section on page 50). 

The companion application software, Measurement Xpress (MX), provides a Graphical User Interface 
(GUI) to make power and other measurements. 

The benefits of using Measurement Xpress are: 

 Familiar Microsoft® Windows Interface 

 Easy to read numbers and bar graphs 

 Fast update rate allows real time circuit tuning 

 Internal zero and cal – the sensor powers up ready to make measurements 

If you wish to program the GT-8550A for automated testing, a Dynamic Link Library (DLL) is included in 
the USB flash drive (memory stick) that ships with the GT-8550A. Information for programming the GT-
8550A is found in the GT-8550A Series USB Power Sensors Remote Operation and Programming Manual. 

Sensor zeroing and meter reference calibration are not required. There is no user calibration. This 
reduces setup time and simplifies programming. Recommended calibration cycle is one (1) year.  

A typical setup for measuring RF power using the GT-8550A Series Power Sensor is shown in Figure 1. 

 
Figure 1. GT-8550A Series Power Sensor Measurement Setup 
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2.2 Sensors in the GT-8550A Series 
The table below lists the basic parameters of the six models of power sensor in the GT-8550A Series. 

Table 1: GT-8550A Series Power Sensors: Basic Specifications and Applications 

GT-8550A Series Power Sensors: Basic Specifications and Applications 

Parameter 

Power Sensor Model 

GT-8551A GT-8552A,  
GT-8555A 

GT-8553A,  
GT-8554A 

GT-8888A 

Frequency 
Range 

100 MHz to 8 GHz 1 100 MHz to 8 GHz 1 

100 MHz to 20 GHz 
10 MHz to 18 GHz  
10 MHz to 26.5 GHz 

10 MHz to 8 GHz 1 
 

Measurements CW, Modulation 

 BAP 2 

 MAP 2 

 PAP 2 

 Crest factor 

CW, Pulse 

 Pulse Profiling 

 Markers 

 Gating 

CW 

 Average Power 
 

CW 

 Average Power 
 

Dynamic range -60 to +20 dBm -60 to +20 dBm 
-40 to +20 dBm 

-50 to +20 dBm -60 to +20 dBm 

Applications Wireless 
communications 
and component 
testing that use 
modulated signals. 

 Aerospace and 
defense: EW, 
ECM, ECCM, and 
radar testing 

 Features Pulse 
Profiling 

Accurate power 
measurement of 
continuous wave (CW) 
RF and microwave 
signals 

Economical power 
measurement of 
CW signals up to 10 
GHz 

1 Operational to 10 GHz 

2 These are explained in section 2.5 on page 4. 
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2.3 Receiving and Inspection 
Upon arrival, inspect the contents of the GT-8550A shipping container. The GT-8550A consists of: 

 Sensor: there are six models of power sensors to choose from. These are described in Table 1 on 
the previous page. 

 USB cable to connect the sensor to a computer (supplied with sensor) 

 USB flash drive containing: 

 Measurement Xpress software (this may also be downloaded from the website 
www.gigatronics.com) 

 Files to enable programming the GT-8550A Series USB Power Sensor. 

2.4 Computer Requirements for Measurement Xpress Software 
Table 2 below shows the requirements of the computer used with the GT-8550A Series USB Power 
Sensors. 

Table 2: Computer Requirements for Measurement Xpress Software 

Computer Requirement for Measurement Xpress Software 

Parameter Specification 

Type of computer IBM-compatible 

Operating System 1 Microsoft® Windows XP or Windows Vista or Windows 7 2 

Processor speed > 500 MHz 

RAM > 256 MB 

USB interface 3 USB 2.0 minimum 

 
1 There are separate installation files for 32 bit and 64 bit Operating Systems. 
2 Microsoft® .Net Framework 4.0 (or above) is required on 64 bit Operating Systems. 
3 See section 2.6 on page 7 for USB considerations. 

 

2.5 Measurement Modes 
This section explains the measurement modes listed in Table 1 on page 3. 

2.5.1 Continuous Wave (CW) 

Use CW for measuring un-modulated CW RF signals. 

  

http://www.gigatronics.com/
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2.5.2 Burst Average Power (BAP) 

The Burst Average Power (BAP) mode measures the average power during an RF burst (See Figure 2). 
This mode is very useful for measurement of pulse modulated signals which are not flat or have 
amplitude modulation during the pulse ON period, as in the case of TDMA (Time Division Multiple 
Access) communications signals. In this mode, the sensor (GT-8551A, GT-8552A, or GT-8555A) 
recognizes the beginning and end of a burst of RF power and takes an average of the power during that 
burst. The RF level can vary over a wide range during the burst as long as it remains above a noise 
threshold, which is automatically calculated by Measurement Xpress. As soon as the RF power drops 
below the noise threshold, the RF burst is complete and all further readings are discarded until the next 
burst starts. 

 
Figure 2. Burst Measurement 

In BAP mode, the sensor automatically determines which portions of the signal are in the pulse and 
which are not. In computing the average power, the sensor uses only those portions that are within the 
pulse. The result is that, independent of the signal’s pulse duty cycle, the meter always reads the 
average power in the pulse or burst. As with the PAP mode, when measuring a pulse modulated signal 
with 50% duty cycle, the reading in the BAP mode would be 3 dB higher than in the MAP mode. 
However, in the BAP mode, the signal’s duty cycle can change dynamically in time without affecting the 
meter reading. In the PAP mode, the duty cycle factor must be entered to match the duty cycle of the 
pulsed signal. 

NOTE: BAP Mode requires a minimum pulse on or off time as determined by the power sensor pulse 
width specification. 
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2.5.3 Modulated Average Power (MAP) 

The Modulated Average Power (MAP) mode measures RF signals which are amplitude modulated, pulse 
modulated, or both. In the MAP mode the sensor (GT-8551A, GT-8552A, or GT-8555A) calculates the 
average RF power received by the sensor over a period of time controlled by the time constant of the 
internal digital filter. The result is comparable to measurement by a thermal power sensor. 

In this mode, the sensor measures the average power of CW and modulated signals, such as: 

 AM 

 Two-tone 

 Multi-carrier 

 Pulse modulation 

 Digital modulation (QPSK, QAM, etc.) 

For example, if an RF signal is pulse modulated at 50 Hz with a 10% duty cycle is measured with the 
averaging factor set to 128, the measured power reading will be 10% of the peak power during pulse ON 
periods. If the signal is modulated at a low pulse rate (below about 1 kHz), the sensor will synchronize 
the readings precisely with the start of a pulse so that each displayed reading is averaged over a whole 
number of pulses (there are no fractional pulses included in the measurement). This eliminates a 
significant amount of noise from the readings. However, even though the filter settling time has been 
set to a long time constant of 2.56 seconds, the update rate of the reading will be much faster; even the 
first reading will be very close to the fully settled value. 

2.5.4 Pulse Average Power (PAP) 

The Pulse Average Power (PAP) mode is similar to the MAP mode, but it measures pulse-modulated 
signals having a known duty cycle. Specify this duty cycle and the sensor (GT-8551A, GT-8552A, or GT-
8555A) will automatically correct the measurements so that the displayed readings indicate the peak RF 
power during pulse ON periods. For example, when measuring a pulse modulated signal with 50% duty 
cycle, MAP mode would give a reading 3 dB lower than the reading that would be given by PAP mode 
with the duty cycle factor set to 50%. 

NOTE:  The duty cycle correction presumes a perfectly rectangular profile for the RF pulse shape. Any 
abnormality such as overshoot, undershoot, slow rise time or fall time, inaccuracy of the duty cycle, or 
deviation from a flat pulse response will cause errors in the indicated reading. 
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2.6 USB Considerations 
Under normal circumstances, the Universal Serial Bus (USB) provides adequate power for the sensor. 
However, when the application requires a longer cable (greater than 3 to 5 meters), an active or self-
powered hub may be required. The sensor electronics are powered by the USB and typically draws 450 
mA at a nominal 5 VDC. An active hub will compensate for the DC voltage drop beyond approximately 3 
to 5 meters. An active hub is recommended when using a portable computer to conserve battery life, or 
when powering multiple sensors. 

The GT-8550A Series USB Power Sensors are compliant with USB standard 2.0 and above. The following 
information is provided for reference when selecting a hub: 

USB Hub Considerations: 

 Bus-powered hub: Draws a maximum of 100 mA at power up and 500 mA during normal 
operation. 

 Self-powered hub:  Draws a maximum of 100 mA and must supply 600 mA to each port. 

 Low power, bus-powered functions: Draws a maximum of 100 mA (often applies to portable 
computers 

 High power, bus-powered functions: Self-powered hubs: draws a maximum of 100 mA and must 
supply 500 mA to each port 

 Suspended device: Draws a maximum of 0.5 mA. 
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2.7 Install Measurement Xpress 
This section describes how to install the Measurement Xpress software on a computer. 

NOTE:  Refer to Table 2 on page 4 for the requirements for the computer in which Measurement Xpress 
will be installed. 

 

Table 3: Installation Procedure for Measurement Xpress 

Install Measurement Xpress 

Step Action 

1.  Connect the GT-8550A Flash Drive to a USB port on the computer. 

2.  Locate and run MXsetup.exe on the GT-8550A Flash Drive. The first setup window is displayed 

(see Figure 3).  

Note: The installation file for 64 bit systems ends with “_x64.exe”.  

 
Figure 3. Measurement Xpress Installation: Welcome Screen 

3.  Click Next in the setup window. 
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Install Measurement Xpress 

Step Action 

4.  In the License Agreement window, read the license agreement, then click on “I accept the license 
agreement,” then click Next. 

 
Figure 4. Measurement Xpress Installation: License Agreement 

 

5.  In the User Information window, fill in the user information fields, then click Next. 

 
Figure 5. Measurement Xpress Installation: User Information 
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Install Measurement Xpress 

Step Action 

6.  In the Destination Folder window, you can leave the destination folder set for the default, or use 
Browse to select another folder. When you have made your choice, click Next. 

 
Figure 6. Measurement Xpress Installation: Destination Folder 

7.  In the Ready to Install window, click Next to proceed with the installation. 

 
Figure 7. Measurement Xpress Installation: Ready to Install 
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Install Measurement Xpress 

Step Action 

8.  Measurement Xpress installs on your computer. 

 
Figure 8. Measurement Xpress Installation: Installation Begins 

9.  The Successful Installation window appears when Measurement Xpress has completed its 
installation. 

 
Figure 9. Measurement Xpress: Installation Successful 

 End of Procedure 
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2.8 Install the GT-8550A Series USB Power Sensors 

 

 
 

                        ESD-SENSITIVE DEVICE 

Observe Electro-Static Discharge precautions when handling the GT-8550A Series USB 
Power Sensor: 

 Work at an ESD-safe workstation 

 Keep the power sensor in an anti-static bag when not using it. 

 Handle the power sensor with appropriate anti-static clothing and wrist strap, or 
other discharge path. 

 

NOTE:  Measurement Xpress software MUST be installed on the computer BEFORE the GT-8550A Series 
USB Power Sensors are connected to the computer. 

After Measurement Xpress has been installed, there are two methods for configuring the computer for 
using the power sensors: 

 Automatic installation: Simply connect the USB power sensor to a USB port on the computer, 
and follow the prompts in the Hardware Wizard. To use this method, go to Table 4 below. 

 Manual installation: Installing the device manually is recommended only if your computer is 
unable to properly identify the correct driver. To use this method, go to Table 5 on page 13. 

Multiple Sensors: To install multiple sensors (up to 12), perform the installation procedure completely  
for each sensor. 

Table 4: Power Sensor Installation (Automatic) 

Automatic Installation of a Power Sensor 

Step Action 

1.  Verify that Measurement Xpress is installed, but not launched on your computer. 

2.  Connect the supplied USB cable to the USB sensor. 

3.  Connect the other end of the USB cable to a USB port on your computer. Observe that the green 
LED on the end of the sensor illuminates. This indicates that the sensor is properly connected to 
the computer’s USB port. (Trigger input applies to GT-8551A, GT-8552A, and GT-8555A only) 

 

 
Figure 10. Back End of USB Power Sensor 

CAUTION 
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Automatic Installation of a Power Sensor 

Step Action 

4.  The Hardware Wizard opens on the computer. 

5.  Click on the Install the Software automatically option, then click Next. 

6.  After the software identifies the Giga-tronics GTPM-855x device, click Next to complete the 
installation process. 

7.  When the installation completes, select “Finish” to close the Hardware Update Wizard. 

The power sensor is now ready for use with Measurement Xpress. 

 End of Procedure 

 

Table 5: Power Sensor Installation (Manual) 

Manual Installation of a Power Sensor 

Step Action 

1.  After connecting the USB power sensor, the computer will indicate “Found New Hardware” and 
automatically open the Hardware Wizard to configure the USB device driver for the power 
sensor. 

2.  Select “Install from a list or specific location (Advanced)” and click Next to continue. 

3.  In the following window, select “Don’t search, I will choose the driver to install,” then click Next. 

4.  Select the Giga-tronics device, then click “Have Disk”.  

5.  Select GTPM_855X.inf and click Open to continue. 

6.  Select “Next” to continue the installation process. 

7.  When the installation completes, select “Finish” to close the Hardware Update Wizard. 

The power sensor is now ready for use with Measurement Xpress. 

End of procedure 
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2.9 Start Measurement Xpress 
 

Table 6: Starting Measurement Xpress 

Start Measurement Xpress 

Step Action 

1.  Connect a GT-8550A Power Sensor to a USB port on your computer. A green LED illuminates on 
the sensor, indicating that it is properly connected to the computer. 

2.  Start Measurement Xpress. Figure 11 shows the initial Measurement Xpress window. The 
Connection Selection window opens every time you start Measurement Xpress. This window 
shows which (if any) USB power sensors are connected to the computer. 

In the Connection Selection window, click on OK to continue. 

Please be patient: This operation may require a few minutes depending on variables such as the 
PC configuration and number of sensors. 

 
Figure 11. Measurement Xpress Initial Display 
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Start Measurement Xpress 

Step Action 

3.  The Connection Selection window disappears, and a Sensor window appears (see Figure 12). 

 
Figure 12. Measurement Xpress with Sensor Window 

4.  If there are multiple sensors connected to the computer, you can open a window for each of 
them at any time. 

In the Navigation window, click on the sensor that you want to open (in this case, Sensor B). See 
Figure 13. 

NOTE: Figure 12 and Figure 13 show Measurement Xpress with two sensors connected. In 
practice, there can be up to 12 sensors connected for Measurement Xpress. 

 
Figure 13. Open a Sensor Window 

 End of Procedure 
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3 Using Measurement Xpress 

3.1 Overview 
This chapter describes in detail the Measurement Xpress (MX) Graphical User Interface (GUI). 

3.2 Main Areas of the Measurement Xpress GUI 

Figure 14 below shows Measurement Xpress with two sensors connected to the computer. The main 
areas of the GUI are bordered in red. 

The next sections describe each of the main areas shown in Figure 14. 

 

 
Figure 14. Measurement Xpress GUI 
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3.3 Menu Bar 
This section describes in detail the menus in the Menu Bar.  

NOTE:  Where a mouse click on a menu item leads to a selection, the symbol >  is used. For example, 
clicking on File in the Menu Bar reveals the selection Exit. This is shown by: 

 File > Exit. 

Table 7: Measurement Xpress Menu Bar 

Measurement Xpress Menu Bar 

Parameter Name Description 

File > Exit Closes Measurement Xpress 

View > Navigation 
Window 

Or 

Opens the Navigation Window (opens by default upon launch of Measurement 
Xpress). 

View > Message 
Window 

Opens the Message Window (opens by default upon launch of Measurement 
Xpress). 

Sensor > Sensor A 

Or 

Sensor > Sensor B 

Clicking on the Sensor menu item shows the sensors that are connected to the 
computer. Clicking on a selection opens that sensor window. Figure 15 shows 
two sensor windows opened. 

 
Figure 15. Sensor Windows 
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Measurement Xpress Menu Bar 

Parameter Name Description 

Sensor Operation > 

Setup 

Sensor Setup/General tab: 

Figure 16 shows the Sensor Setup window that opens when you select Setup. 

 
Figure 16. Sensor Setup Window, General Tab 

 Mode: selects the measurement mode. The model of GT-8550A sensor 
determines the type of measurements you can make. The measurement 
mode choices are: 

 CW 

 MAP 

 BAP 

 PAP 

These measurement modes are explained in section 2.5 on page 4. 
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Measurement Xpress Menu Bar 

Parameter Name Description 

Sensor Operation > 

Setup 

General tab (continued): refer to Figure 16 on page 18. 

 Power Unit: selects the measurement unit that best suits your application. 

 Averages: use when measuring a CW signal that varies in power over time. 
Minimal averaging is 1, which averages the power measurement over 
approximately 0.5 ms. If the signal’s power variation is slower, a greater 
average number must be used. Generally, the correct Averaging setting 
can be found by starting with a small number, and increasing it until CW 
readings stabilize. 

 Duty Cycle: available only in PAP measurement mode (see section 2.5.4 on 
page 6). Enter the duty cycle of the signal to ensure accurate readings. 

 Alarm Power Limits (Upper and Lower): allows you to select power levels 
for activating the alarm. 

 Enable limits: activates the alarm according to the limits set in the 
previous item. 

 Frequency: sets the frequency of the measured signal. 

 Relative (Reset): Power Unit must be set to dB Relative to enable this 
function. Whenever you click on Relative (Reset), the power indication in 
the Sensor window updates to show the RF power at the moment the 
Reset button was clicked. This is useful if the power level of the signal is 
drifting. 

 Modulation Bandwidth: this is a form of anti-alias which filters the 
readings. To enable this filter, select “BW > = 200 kHz.” 

 Offset: offsets the readings by the amount entered into “dB” field. 

 Enable Offset: enables offset. 
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Measurement Xpress Menu Bar 

Parameter Name Description 

Sensor Operation > 

Setup 

Sensor Setup/Display Tab 

The settings in this window determine the information displayed in the Sensor 
Windows. Figure 17 shows all of the settings in the Display tab selected, and 
Figure 18 shows the result of selecting all display options. 

 
Figure 17. Sensor Setup Window/Display Tab 

 
Figure 18. Sensor Window with All Display Options Selected 



Giga-tronics GT-8550A Series USB Power Sensors  Using Measurement Xpress 

Operation Manual, Part Number 34780 Rev. F, Oct. 6, 2011 Page 21 

Measurement Xpress Menu Bar 

Parameter Name Description 

Sensor Operation > 

Setup 

Sensor Setup/Display Tab, Continued 

When CW mode is selected on the General tab, only Offset, Min Power, and 
Max Power is available as a selection. 

When any other measurement mode is selected, all of the following selections 
are available: 

 Offset: 

 Peak Power: 

 Avg Power: 

 Duty Cycle: 

 Crest Factor: 

 Min Power: 

 Max Power: 

 Sensor Setup/Trigger Tab 

The settings in this window configure the external and internal triggers, and 
the recorder output. See Figure 19 below. 

 
Figure 19. Sensor Setup Window/Display Tab 
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Measurement Xpress Menu Bar 

Parameter Name Description 

Sensor Operation > 

Setup 

Sensor Setup/Trigger tab, Continued 

External Trigger In: 

 Enable External Trigger: 

 Enable Falling Edge: 

 Timeout: 

Internal Trigger: 

 Pulse Criteria 

 

NOTE: Trigger out and Recorder Out features are not active at this time, but 
may be made available on future power USB sensor models. 

Sensor Operation > 

Pulse Profiling 

Selecting Pulse Profiling opens the Pulse Profiling window (see Figure 20 
below). 

NOTE: The Pulse Profiling window and functions are described in detail in 
section 3.9 starting on page 39. 

 
Figure 20. Pulse Profiling Window 
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Measurement Xpress Menu Bar 

Parameter Name Description 

System > Interface Selecting System/Interface (see Figure 21) opens the Connection Interface 
window (see Figure 22). 

 
Figure 21. Selecting System/Interface 

 
Figure 22. Connection Interface Window 

  Identifies the available sensors by model number. 

 Allows you to select or deselect the connection of sensors to 
Measurement Xpress. 

 Allows you to change the USB port address of a sensor. 

 Allows for Measurement Xpress to automatically detect and configure 
sensors. 

 Allows you to run Measurment Xpress with out sensors, for the purpose of 
learning about, or demonstrating, Measurement Xpress. 

5 

4 

3 

2 

1 
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Measurement Xpress Menu Bar 

Parameter Name Description 

System > General Info Selecting General Info from the System menu opens the General Information 
window (see Figure 23). 

 
Figure 23. General Information Window 

Information in this window includes: 

 Sensor letter assignments (A, B) 

 The model number of the GT-8550A Power Sensor connected to the 
computer. 

 The serial number(s) of the GT-8550A Power Sensors connected to the 
computer. 

 The address of the USB ports the GT-8550A Power Sensors are 
connected to. 

 The version of the Giga-tronics Dynamic Link Library (DLL) installed in 
the computer. 

 The version of the Giga-tronics firmware installed in the computer. 
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Measurement Xpress Menu Bar 

Parameter Name Description 

Math > Math Setup Selecting Math > Math Setup (see Figure 24) from the Menu Bar opens the 
Math Setup window (see Figure 25). 

 
Figure 24. Selecting Math/Math Setup from the Menu Bar 

 
Figure 25. Math Setup Window 

This window allows you to apply basic math operations between two 
GT-8550A Power Sensors, or between a sensor and a constant. The operations 
are: 

 Addition (+) 

 Subtraction (-) 

 Ratio (/) 
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Measurement Xpress Menu Bar 

Parameter Name Description 

Strip Chart > 

      Strip Chart Setup 

Selecting Strip Chart > Strip Chart Setup (see Figure 26) opens the Strip Chart 
Setup window (see Figure 27). 

 
Figure 26. Selecting Strip Chart/Strip Chart Setup 

 
Figure 27. Strip Chart Setup Window 

The settings for this window are: 

 Sensors: Select which sensors to use for the strip chart. 

 Sample Rate: 

 Samples per second, minute, hour, day 

 Duration: The amount of time the strip chart will record 

 Name and save: Allows you to name and save individual strip chart 
files. 
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Measurement Xpress Menu Bar 

Parameter Name Description 

Strip Chart > 

               Strip Chart 

Selecting Strip Chart > Strip Chart opens the Strip Chart window as shown in 
Figure 28. Notice the following: 

 Two sensors are shown, A and B, and they are color-coded. 

 Sensor A is detecting a constant power source 

 Sensor B is detecting a source that is ramping in power approximately 
every 14 seconds. 

 
Figure 28. Strip Chart Window 

 

Windows Allows you to configure the layout of the Measurement Xpress GUI 

Help/About Displays information about the version of Measurement Xpress you are using. 

 End of Procedure 
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3.4 Configure the GT-8550A Series USB Power Sensors 
 

Before any measurements are made in Measurement Xpress, the GT-8550A Power Sensors must be 
configured. This section describes how to configure the power sensors. 

Table 8: Configure the GT-8550A Series USB Power Sensor 

Configure the GT-8550A Series USB Power Sensors 

Step Action 

1.  Install the GT-8550A Power Sensors as described in section 2.8 on page 12. 

2.  Start Measurement Xpress as described in section 2.9 on page 14. 

3.  Open a sensor window for each sensor connected to the computer: 

On the Menu Bar, select Sensor > Sensor X (where X is any sensor that doesn’t have a sensor 
window opened).   

 
Figure 29. Opening Sensor Windows 

4.  Repeat the previous step until all sensors connected to the computer have an open sensor 
window in the display area. Figure 30 shows sensor windows open for two sensors. 

NOTE: When you open Sensor Windows, you can drag and dock them to a convenient location, 
as shown in Figure 30. 

 
Figure 30. Two GT-8550A Power Sensors Connected to the Computer 

5.  Click on a Sensor Window to select that sensor for configuration. 
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Configure the GT-8550A Series USB Power Sensors 

Step Action 

6.  On the Menu Bar, select Sensor Operation > Setup (see Figure 31). 

 
Figure 31. Select Sensor Operation/Setup 

7.  The Sensor Setup window appears (see Figure 32). 

 
Figure 32. Sensor Setup Window 

8.  Configure the Sensor Setup window according to your testing needs. Complete information on 
configuring the Sensor Setup Window is available starting on page 18. 

9.  When you have finished configuring the sensor, click on Apply&Close to apply the settings to the 
sensor. 

10.  If you want to configure other sensors, repeat these instructions, starting at Step 5. 

 End of Procedure 
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3.5 Measure CW Power 
This section describes how to use Measurement Xpress to make CW power measurements. 

 

Table 9: Measure CW Power 

Measure CW Power 

Step Action 

1.  If necessary, do the following: 

 Connect the GT-8550A USB Power Sensors to the computer (see section 2.8 on page 12). 

 Configure the sensors (see section 3.4 on page 28). 

 

 

 

DO NOT APPLY EXCESSIVE POWER TO THE GT-8550A SERIES USB POWER SENSORS. 

 Read the specifications for the power sensor (see Table 1 on page 3) 

 Know the approximate power level of the signal of interest before applying it to 
the GT-8550A. 

2.  Before connecting the RF signal to the GT-8550A Power Sensor, de-energize (turn OFF) the RF 
signal. 

3.  Connect the GT-8550A Power Sensor to the RF source. 

4.  There are different ways to measure CW power. Choose among the following: 

 To determine RF power: use the Sensor window (see Figure 15 on page 17). 

 If you want to view a CW source that is changing over time: use the Strip Chart (see page 26). 

End of Procedure 

 

 

 

  

CAUTION 
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3.6 Measure Pulse Power 
Measurement Xpress makes it possible to measure and view different aspects of pulse power. We 
recommend that you review the different pulse-power measuring methods offered by Measurement 
Xpress in section 2.5 starting on page 4, and the appropriate sensor for the measurement. 

 

Table 10: Measure Pulse Power 

Measure Pulse Power 

Step Action 

1.  If necessary, do the following: 

 Connect the appropriate GT-8550A Series USB Power Sensors to the computer (see section 
2.8 on page 12). 

 Configure the sensors for making pulse measurements according to your test needs 
(see section 3.4 on page 28). 

 

 

 

DO NOT APPLY EXCESSIVE POWER TO THE GT-8550A SERIES USB POWER SENSORS. 

 Read the specifications for the power sensor (see Table 1 on page 3) 

 Know the approximate power level of the signal of interest before applying it to 
the GT-8550A. 

2.  Before connecting the RF signal to the GT-8550A Power Sensor, de-energize (turn OFF) the RF 
signal. 

3.  Connect the GT-8550A Power Sensor to the RF source. 

4.  Energize the RF signal. 

5.  Figure 33 shows the Sensor A window under the following example conditions: 

 Sensor type: GT-8552A USB Power Sensor 

 RF input: square wave; pulse period, 80 us; pulse width, 40 us; power, 1 dBm 

 Measurement settings: note the settings in the Sensor Window bordered in red (see Figure 
33 below). 

 
Figure 33. Sensor A Window 

 

CAUTION 
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Measure Pulse Power 

Step Action 

6.  Figure 34 uses Pulse Profiling to display the same signal shown in Figure 33 on the page 31. Note 
the use of markers and a gate. Figure 34 includes blow-ups of the Marker Status and Gate Status 
panes. 

 
Figure 34. Pulse Profiling 

 End of Procedure  
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3.7 Use the Math Functions 
This procedure describes how to use the math functions of Measurement Xpress. The math functions 
enable you to add, subtract, or divide the outputs of two sensors, or of one sensor to a settable 
constant. 

To demonstrate the Math functions, we will connect a 1 dBm, 1 GHz CW signal to a GT-8550A Power 
Sensor. 

 

Table 11: User the Math Functions 

Use the Math Functions 

Step Action 

1.  If necessary, do the following: 

 Connect the GT-8550A Power Sensor to the computer (see section 2.8 on page 12). 

 Configure the sensors for making CW measurements (see section 3.4 on page 28). 

 

 

 

DO NOT APPLY EXCESSIVE POWER TO THE GT-8550A SERIES USB POWER SENSORS. 

 Read the specifications for the power sensor (see Table 1 on page 3) 

 Know the approximate power level of the signal of interest before applying it to 
the GT-8550A. 

2.  Setup Measurement Xpress to display sensor windows for both USB power sensors. See Figure 
35. 

 
Figure 35. Measurement Xpress with Two Power Sensors 

 

CAUTION 



Using Measurement Xpress  Giga-tronics GT-8550A Series USB Power Sensors 

Page 34 Operation Manual, Part Number 34780 Rev. F, Oct. 6, 2011 

Use the Math Functions 

Step Action 

3.  On the Menu bar, click on Math > Math Setup (see Figure 36). 

 
Figure 36. Select math Setup 

4.  The Math Setup window opens (see Figure 37). In this window: 

 Select the relationship between the sensors. 

 In the middle field in the window, click the down arrow ( V ) to select the math function 
you require ( /, +, or – ). 

 Click on Apply&Close. 

 
Figure 37. Math Setup Window 
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Use the Math Functions 

Step Action 

5.  The Math Setup window closes, and the Math Status window opens (see Figure 38). 

Notice that the Math Status window constantly updates the resultant value as the individual 
sensor outputs change. 

 
Figure 38. Math Status Window 

6.  You can close the Math Status window anytime by clicking on the        in the upper right-hand 
corner of the window. 

 End of Procedure 

 

 

 

 

  

X 
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3.8 Use the Strip Chart Function 
This section describes how to use the Strip Chart function of Measurement Xpress. 

 

Table 12: Use the Strip Chart Function 

Use the Strip Chart Function 

Step Action 

1.  Configure the power sensors according to your application. Figure 39 below shows Measurement 
Xpress configured to display two sensors. 

 
Figure 39. Measurement Xpress Configured to Display Two Power Sensors 

2.  On the Menu bar, click on Strip Chart > Strip Chart Setup (see Figure 40). 

 
Figure 40. Selecting Strip Chart Setup 
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Use the Strip Chart Function 

Step Action 

3.  The Strip Chart Setup dialog box opens. Configure the strip chart (see Figure 41): 

 Select which sensor(s) the strip chart will record. 

 Select the Sample Rate 

 Select the Duration 

 Name and save the file for the strip chart file. There are no name or location restrictions 
on naming and saving these files. 

 NOTE: The Strip Chart saves the information as a Comma Separated Values (CSV) file, 
which can be opened in Microsoft Excel. 

 
Figure 41. Strip Chart Setup 

4.  Click Apply&Close to apply the settings and close the Strip Chart Setup window. 
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Use the Strip Chart Function 

Step Action 

5.  The strip chart window opens. Click on Start to begin recording on the strip chart (see Figure 42). 
Note the following about Figure 42: 

 Both power sensors are shown, and each is color-coded: Sensor A is blue, and Sensor B is 
pink. 

 
Figure 42. The Strip Chart Window 

6.  When you clicked on Start in the Strip Chart window, Start changed to Stop. Press Stop anytime 
to stop the strip chart. 

 End of Procedure 
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3.9 The Pulse Profiling Window 
This section describes the parameter you can set and view in the Pulse Profiling window (see Figure 43 
below). 

To open the Pulse Profiling window, you must use a GT-8552A or GT-8555A USB Power Sensor. When 
the sensor is connected to the computer, and its sensor window is open and selected, the Pulse Profiling 
function is enabled both in the Menu Bar, and in the Navigation Window (Sensor Operation/Pulse 
Profiling). Click on either of these to open the Pulse Profiling window. 

The settings and features available for the Pulse Profiling are described on the following pages. 

 
Figure 43. Pulse Profiling Window 

 

Table 13: The Pulse Profiling Window 

The Pulse Profiling Window 

Parameter Description 

Settings:  

Sweep time Allows you to enter the duration of a sweep. 

Start/Stop Starts and stops the sweep. This is a toggled selection; clicking on it changes it to 
the opposite state. 

Single Starts a single sweep. 

Reset Removes all markers and gates from the display. 
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The Pulse Profiling Window 

Parameter Description 

Settings: Marker Clicking on this button allows you to place up to ten markers on the display. When 
you click on the Marker button, its color changes to red. You can then place 
markers anywhere on the display. Note that the markers are color-coded. 

NOTE: to delete markers, see Figure 44. 

 To delete all markers, click on Reset in Settings. 

 To delete individual markers, select a marker in the Marker Status area, 
then right-click on the selection to display more options, and left-click on 
Delete MarkerX. 

 
Figure 44. Deleting Markers 

Settings: Marker 

(continued) 

Marker information: For each marker placed on the sweep display, a line of 
information appears in the Marker status pane. The information for each marker 
is updated regularly (see Figure 45). 

 
Figure 45. Marker Status Pane 
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The Pulse Profiling Window 

Parameter Description 

Settings: Marker 

(continued) 

Enable delta between markers: To view the difference (delta) between markers 
(see Figure 46): 

1. Click on one of the markers in the Marker Status pane. 

2. Right-click on the selected marker to open the options pane. 

3. Select one of the delta options. 

 
Figure 46. Turning On Delta Between Markers 
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The Pulse Profiling Window 

Parameter Description 

Settings: Marker 

(continued) 

All peak settings: To apply a peak setting to a marker, first select the marker you 
want to apply the peak setting to as shown in Figure 47. 

 
Figure 47. Selecting a Marker for Peak Setting 

Prev Pk Places the selected marker at the previous peak. 

Peak Places the marker at the highest point of the signal. 

Next Peak Places a marker at the next peak in the sweep. 
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The Pulse Profiling Window 

Parameter Description 

Settings: Gate Clicking on Gate enables you to place up to six gates anywhere on the sweep 
display. Figure 48 shows two gates on the sweep display. 

To place gates: 

1. Click on the Gate button in the Navigation Window (the Gate button turns 
red). 

2. Mouse-click at those points on the sweep display where you want to 
place a gate. 

To adjust the width of a gate 

NOTE:  In order to view information within a gate, you must adjust its width after 
placing it, as follows: 

1. Click and hold on one of the vertical lines of the gate, and drag it to the 
desired point on the sweep display. Do the same action on the other 
vertical line of the gate. 

2. Perform Step 1 on the other gates if desired. 

 
Figure 48. Gates 
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The Pulse Profiling Window 

Parameter Description 

Settings: Gate Gate information: After adjusting the width of a gate, you can view the gate’s 
information in the Gate Status pane (see Figure 49). 

 
Figure 49. Gate Status Pane 
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The Pulse Profiling Window 

Parameter Description 

Settings: 

Zoom In/Out 

Zoom In/Out gives you the ability to magnify areas of interest of the sweep in 
Pulse Profiling. 

o zoom in on a point: 

1  Click on + under Zoom In/Out (see Figure 50). Note that the + turns red. 

2  Place the mouse cursor on the sweep display where you want the 
magnification to be centered (the red circle was added to the figure to 
show the cursor placement; it doesn’t appear in the application).  

3  Click on the chosen point on the sweep display until you achieve the 

desired level of magnification (see Figure 51). Use Zoom Out (-) to fine-

tune the display. 

 
Figure 50. Clicking on Plus (+) 

 
Figure 51. Sweep Magnified by Using Zoom In 

To return the display to normal, either click on Zoom Out until you have restored 
the normal display, or click Reset. 

NOTE: Clicking Reset will also delete all Markers and Gates. 

 End of Procedure 
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3.10 Use Pulse Profiling 
The Pulse Profiling function is a powerful feature of Measurement Xpress. Pulse Profiling allows you to 
see and measure many aspects of pulse waveforms. The following procedure describes how to use the 
Pulse Profiling function. 

NOTE: To enable Pulse Profiling, you must use a GT-8552A or GT-8555A USB Power Sensor. 

Table 14: Measurement Xpress: Use Pulse Profiling 

Measurement Xpress: Use Pulse Profiling 

Step Action 

1.  You must use a GT-8552A or GT-8555A USB Power Sensor to enable Pulse Profiling. Connect a 
GT-8552A or GT-8555A to a USB port on the computer. 

2.  Start Measurement Xpress. 

 

 

 

DO NOT APPLY EXCESSIVE POWER TO THE GT-8552A or GT-8555A USB POWER 
SENSOR. 

 Read the specifications for the power sensor (see Table 1 on page 3) 

 Know the approximate power level of the signal of interest before applying it to 
the GT-8552A or GT-8555A. 

3.  Connect the signal of interest to the RF connector on the end of the GT-8552A or GT-8555A 
power sensor. 

4.  If there is more than one GT-8550A Power Sensor connected to the computer, select the 
GT-8552A or GT-8555A in order to enable Pulse Profiling. 

5.  Configure the measurement settings by opening the Sensor Setup Window: 

1. In the Navigation pane, click on Setup (under Sensor Operation). 

2. Configure the settings in the Sensor Setup window as desired. 

3. Close the Sensor Setup window. 

CAUTION 
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Measurement Xpress: Use Pulse Profiling 

Step Action 

6.  In the Navigation Window, click on Pulse Profiling to open the Pulse Profiling window 
(see Figure 52). 

 
Figure 52. Opening the Pulse Profiling Window 

7.  The Pulse Profiling window opens (see Figure 53). To view pulses, click on Start in the Pulse 
Profiling window. 

 
Figure 53. Pulse Profiling Window (Before Start is clicked) 
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Measurement Xpress: Use Pulse Profiling 

Step Action 

8.  When you click on the Start button, you can view pulses (see Figure 54). Notice that the Start 
button changes to the Stop button. This button toggles states whenever it is clicked. 

 
Figure 54. Pulse Profiling Window (After Start is clicked) 

9.  If necessary, adjust the Sweep Time to get a better view of the pulses of interest. 

 
Figure 55. Adjust Sweep Time 
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Measurement Xpress: Use Pulse Profiling 

Step Action 

10.  You can now place markers and gates to obtain the information you desire from the sweep 
display. Refer to section 3.9 starting on page 39 for details on placing and using markers and 
gates.Figure 56 shows a sweep with two markers and two gates, and their data shown in the 
Marker Status and Gate Status panes. 

 
Figure 56. Markers and Gates on the Pulse Profiling Window 

11.  You can close the Pulse Profiling window at any time by clicking on the X in the upper right-hand 
corner of the window. 

 End of Procedure 
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4 Specifications 

4.1 General Specifications for all GT-8550A Series Power Sensors 
 

Table 15: General Sensor Specifications 

General Sensor Specifications 

Parameter Specification 

USB voltage +4.5 V to +5.5 V 

USB power 450 mA typical, 500 mA maximum 

Operating temperature 0 °C to 50 °C 

Storage temperature -20 °C to +75 °C 

USB cable length 15 ft. (5 m) maximum 

Dimensions  
(GT-8551A, GT-8552A, GT-8888A) 

2” H x 2.5” W x 3” D (50 mm H x 65 mm W x 75 mm D) 

Dimensions  
(GT-8553A, GT-8554A, GT-8555A) 

2” H x 2.5” W x 3.5” D (50 mm H x 65 mm W x 90 mm D) 

Weight < 1 lbs (< 0.5 kg) 

Environmental MIL-PRF-28800F, Class 3 

WEEE compliant, RoHS compliant 

Safety EN 61010 and CE compliant 

Emissions EN 61326 and FCC compliant 

Video bandwidth GT-8551A, GT-8552A, and  
GT-8555A: 10 MHz minimum 

GT-8553A, GT-8554A and GT-8888A: 
100 Hz typical 

Measurement speed 2000 Reading/second typical 

Maximum  
peak-to-average ratio 

GT-8551A, GT-8552A, GT-8553A, GT-8554A, GT-8888A: 70 dB typical  
GT-8555A: 55 dB typical 

RF Input Connector GT-8551A, GT-8552A, GT-8553A, GT-8888A: Low VSWR, Type-N (m) 

GT-8554A, GT-8555A: Low VSWR, SMA (m)  

USB Port Rugged 4-Pin USB 

 

Frequency range 

GT-8551A and GT-8552A 100 MHz to 8 GHz, operational to 10 GHz 

GT-8553A 10 MHz to 18 GHz 

GT-8554A 10 MHz to 26.5 GHz 

GT-8555A 100 MHz to 20 GHz 

GT-8888A 10 MHz to 8 GHz, operational to 10 GHz 

 
Continued on next Page 
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General Sensor Specifications 

Parameter Specification 

Dynamic range 

GT-8551A, GT-8552A  
and GT-8888A 

100 MHz to 6 GHz: 
-60 dBm to +20 dBm 

6 GHz to 8 GHz: 
-50 dBm to +20 dBm 

GT-8553A and GT-8554A -50 dBm to +20 dBm 

GT-8555A  -40 dBm to +20 dBm 

Maximum peak input power 
(damage level) 

+23 dBm (200 mW) 

Maximum input voltage: 25 VDC 

 
VSWR 

GT-8551A 100 MHz to 250 MHz: 

1.18:1 

250 MHz to 8 GHz: 

1.15:1 

8 GHz to 10 GHz: 
1.18:1 typical 

GT-8552A 100 MHz to 250 MHz: 

1.18:1 

250 MHz to 8 GHz: 

1.15:1 

8 GHz to 10 GHz: 

1.18:1 typical 

GT-8553A 10 MHz to 10 GHz: 1.20:1 10 GHz to 18 GHz: 1.30:1 

GT-8554A 10 MHz to 10 GHz: 1.20:1 10 GHz to 26.5 GHz: 1.30:1 

GT-8555A 100 MHz to 10 GHz: 1.20:1 10 GHz to 20 GHz: 1.29:1 

GT-8888A 10 MHz to 8 GHz: 1.15:1 8 GHz to 10 GHz: 1.18:1 typical 

Trigger Input function 

(applies only to GT-8551A, GT-8552A, and GT-8555A sensors) 

Rate 1 Hz to 750 kHz 

Resolution 20.8 ns 

Modes Single or Continuous 

Trigger Source Internal or External 

Internal Trigger Level Range -20 dBm to +20 dBm (Manual or Auto) 

External Trigger Input TTL compatible, rising or falling edge 

Operating Input Levels 0.0 V to 0.8 V (low), 2.0 V to 5.0 V (high), +/- 10 μA 

Maximum Input Levels -0.5 V (low) to 5.5 V (high) 

Trigger Off Time 1 μs minimum for reliable triggering 
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Table 16: General Sensor Measurement Capabilities 

General Sensor Measurement Capabilities 

Parameter Measurement Capability 

Strip Chart Mode Multiple Sensor, Adjustable Rate and Duration, and Data Logging Output 
File (CSV) 

Statistical Chart Mode Adjustable Rate, Duration, Range and Resolution, Histogram, CDF and CCDF 

Math Functions Ratio, Sum and Difference between sensors or between sensors and a 
constant 

Other Capabilities Selectable Power Units, Relative Function, Offset Function, Adjustable 
Averaging, Upper and Lower Alarm Limits, and Min and Max Hold 
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4.2 Sensor Measurement Uncertainty Factors 

4.2.1 Accuracy 

Measurement uncertainty is computed from the individual cal factor, mismatch, linearity, noise and 
temperature error factors, and can be computed as either worst case (sum of the applicable error 
terms) or RSS, representing the most probable error, where RSS is the square root of the sum of the 
squares of the error terms. 

Accuracy is typically < 2 % (RSS) mid-band with source VSWR 1.2:1 (or better) at 25 °C +/- 5 °C. 

This section presents correction factors for various aspects of sensor measurements. 

Table 17: GT-8551A Measurement Uncertainty Factors 

GT-8551A Measurement Uncertainty Factors 

Parameter Specification 

Calibration Factor 100 MHz to 0.5 GHz 0.5 GHz to 8 GHz 

-60 to +20 dBm 4 % 1.7 % 

Linearity 100 MHz to 2 GHz 2 GHz to 8 GHz 

+15 to +20 dBm 7 % 5 % 

+10 to +15 dBm 5 % 3 % 

-60 to +10 dBm 3 % 2 % 

Noise 1 100 MHz to 6 GHz 6 GHz to 8 GHz 

-30 to +20 dBm 0.02 % 0.04 % 

-50 to -30 dBm 0.04 % 0.15 % 

-60 to -50 dBm 0.11 % N/A 

Temperature 0 °C to 10 °C 10 °C to 20 °C 20 °C to 30 °C 30 °C to 40 °C 40 °C to 50 °C 

-60 to 0 dBm 1 % 0.75 % 0 % 0.75 % 1 % 

0 to +10 dBm 2 % 1.75 % 0 % 1.75 % 2 % 

+10 to +20 dBm 4 % 3.75 % 0 % 3.75 % 4 % 

Zero Offset 100 MHz to 8 GHz 

-60 to +20 dBm 0.35 nW typical at 25 °C, 1.7 nW typical at 0 °C to 50 °C 

 
1 Noise measured with a 5 second integration time. 
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Table 18: GT-8552A Measurement Uncertainty Factors 

GT-8552A Measurement Uncertainty Factors 

Parameter Specification 

Calibration Factor 100 MHz to 0.5 GHz 0.5 GHz to 8 GHz 

-60 to +20 dBm 4 % 1.7 % 

Linearity 100 MHz to 2 GHz 2 GHz to 8 GHz 

+15 to +20 dBm 7 % 5 % 

+10 to +15 dBm 5 % 3 % 

-60 to +10 dBm 3 % 2 % 

Noise 1 100 MHz to 6 GHz 6 GHz to 8 GHz 

-30 to +20 dBm 0.02 % 0.04 % 

-50 to -30 dBm 0.04 % 0.15 % 

-60 to -50 dBm 0.11 % N/A 

Temperature 0 °C to 10 °C 10 °C to 20 °C 20 °C to 30 °C 30 °C to 40 °C 40 °C to 50 °C 

-60 to 0 dBm 1 % 0.75 % 0 % 0.75 % 1 % 

0 to +10 dBm 2 % 1.75 % 0 % 1.75 % 2 % 

+10 to +20 dBm 4 % 3.75 % 0 % 3.75 % 4 % 

Zero Offset 100 MHz to 8 GHz 

-60 to +20 dBm 0.35 nW typical at 25 °C, 1.7 nW typical at 0 °C to 50 °C 

 
1 Noise measured with a 5 second integration time. 
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Table 19: GT-8553A Measurement Uncertainty Factors 

GT-8553A Measurement Uncertainty Factors 

Parameter Specification 

Calibration Factor 10 MHz to 1.0 GHz 1 GHz to 10 GHz 10 GHz to 18 GHz 

-50 to +20 dBm 1.8 % 1.7 % 1.9 % 

Linearity 10 MHz to 18 GHz 

+15 to +20 dBm 3 % 

-15 to +15 dBm 2.5 % 

-50 to -15 dBm 2 % 

Noise 1 10 MHz to 18 GHz 

-30 to +20 dBm 0.1 % 

-40 to -30 dBm 0.25 % 

-50 to -40 dBm 0.5 %  

Temperature 0 °C to 10 °C 10 °C to 20 °C 20 °C to 30 °C 30 °C to 40 °C 40 °C to 50 °C 

-50 to +20 dBm 2 % 0.75 % 0 % 0.75 % 2 % 

Zero Offset 10 MHz to 18 GHz 

-50 to +20 dBm 1 nW typical at 25 °C, 5 nW typical at 0 °C to 50 °C 

 
1 Noise measured with a 5 second integration time. 
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Table 20: GT-8554A Measurement Uncertainty Factors 

GT-8554A Measurement Uncertainty Factors 

Parameter Specification 

Calibration Factor 10 MHz to 10 GHz 10 GHz to 18 GHz 18 GHz to 26.5 GHz 

-50 to +20 dBm 2.5 % 2.7 % 3.7 % 

Linearity 10 MHz to 26.5 GHz 

+15 to +20 dBm 3 % 

-15 to +15 dBm 2.5 % 

-50 to -15 dBm 2 % 

Noise 1 10 MHz to 26.5 GHz 

-30 to +20 dBm 0.1 % 

-40 to -30 dBm 0.25 % 

-50 to -40 dBm 0.5 %  

Temperature 0 °C to 10 °C 10 °C to 20 °C 20 °C to 30 °C 30 °C to 40 °C 40 °C to 50 °C 

-50 to +20 dBm 2 % 0.75 % 0 % 0.75 % 2 % 

Zero Offset 10 MHz to 26.5 GHz 

-50 to +20 dBm 1 nW typical at 25 °C, 5 nW typical at 0 °C to 50 °C 

 
1 Noise measured with a 5 second integration time. 
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Table 21: GT-8555A Measurement Uncertainty Factors 

GT-8555A Measurement Uncertainty Factors 

Parameter Specification 

Calibration Factor 100 MHz to 0.5 GHz 0.5 GHz to 12.5 GHz 12.5 GHz to 18 GHz 18 GHz to 20 GHz 

-40 to +20 dBm 4 % 2.6 % 3.2 % 3.5 % 

Linearity 100 MHz to 2 GHz 2 GHz to 20 GHz 

+15 to +20 dBm 7 % 6 % 

+5 to +15 dBm 5 % 4 % 

-40 to +5 dBm 3 % 2 % 

Noise 1 100 MHz to 20 GHz  

-30 to +20 dBm 0.25 %  

-40 to -30 dBm 0.50 %  

Temperature 0 °C to 10 °C 10 °C to 20 °C 20 °C to 30 °C 30 °C to 40 °C 40 °C to 50 °C 

-40 to +20 dBm 2.5 % 1.25 % 0 % 1.25 % 2.5 % 

Zero Offset 100 MHz to 20 GHz 

-40 to +20 dBm 0.25 nW typical at 25 °C, 0.75 nW typical at 0 °C to 50 °C 

 
1 Noise measured with a 5 second integration time. 
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Table 22: GT-8888A Measurement Uncertainty Factors 

GT-8888A Measurement Uncertainty Factors 

Parameter Specification 

Calibration Factor 10 MHz to 0.1 GHz 0.1 GHz to 0.5 GHz 0.5 GHz to 8 GHz 

-60 to +20 dBm 7 % 4 % 1.7 % 

Linearity 10 MHz to 2 GHz 2 GHz to 8 GHz 

+15 to +20 dBm 7 % 5 % 

+10 to +15 dBm 5 % 3 % 

-60 to +10 dBm 3 % 2 % 

Noise 1 10 MHz to 0.1 GHz 0.1 GHz to 6 GHz 6 GHz to 8 GHz 

-30 to +20 dBm 0.22 % 0.02 % 0.04 % 

-50 to -30 dBm 0.22 % 0.04 % 0.15 % 

-60 to -50 dBm 0.44 % 0.11 % N/A 

Temperature 0 °C to 10 °C 10 °C to 20 °C 20 °C to 30 °C 30 °C to 40 °C 40 °C to 50 °C 

-60 to 0 dBm 1 % 0.75% 0 % 0.75 % 1 % 

0 to +10 dBm 2 % 1.75 % 0 % 1.75 % 2  % 

+10 to +20 dBm 4 % 3.75 % 0 % 3.75 % 4 % 

Zero Offset 10 MHz to 8 GHz 

-60 to +20 dBm 0.35 nW typical at 25 °C, 1.7 nW typical at 0 °C to 50 °C 

 
1 Noise measured with a 5 second integration time. 
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4.3 Additional Technical Specifications 
 

Table 23: GT-8551A Additional Measurement Capabilities 

GT-8551A Additional Measurement Capabilities 

Parameter Measurement Capability 

BAP Mode Pulse Power, Peak Power, Average Power, Duty Cycle and Crest Factor 

MAP Mode Peak Power, Average Power, Duty Cycle and Crest Factor 

PAP Mode Duty Cycle Corrected Power, Peak Power, Average Power and Crest Factor 

 

Table 24: GT-8552A and GT-8555A Additional Technical Specifications 

GT-8552A and GT-8555A Additional Technical Specifications 

Parameter Specification 

Sample Rate 48 MS/s 

Rise/Fall Time < 55 ns (10% to 90%) at 4 GHz 

Minimum Pulse Width 1 100 nS typical 

Minimum Duty Cycle 2 0.01% 

 
1 The minimum pulse width is the recommended minimum pulse width viewable on the power meter, 
where power measurements are meaningful and accurate, but not warranted.  

2 The minimum duty cycle is the recommended minimum duty cycle viewable on the power meter, 
where power measurements are meaningful and accurate, but not warranted. 

 

Table 25: GT-8552A and GT-8555A Additional Measurement Capabilities 

GT-8552A and GT-8555A Additional Measurement Capabilities 

Parameter Measurement Capability 

Pulse Profiling Gated 
Measurements 

Peak Power, Average Power, Crest Factor, Droop, Overshoot, Rise Time and 
Fall Time, Duty Cycle, Pulse Repetition Frequency, Pulse Repetition Interval 
and Pulse Width 

Pulse Profiling Marker 
Measurements 

Peak Power and Delta Markers 

BAP Mode Pulse Power, Peak Power, Average Power, Duty Cycle and Crest Factor 

MAP Mode Peak Power, Average Power, Duty Cycle and Crest Factor 

PAP Mode Duty Cycle Corrected Power, Peak Power, Average Power and Crest Factor 
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